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1 Introduction

This document consists of a summary of the basic functions in Phon. It is organized following the types of 
workflow you may want to use corpus creation, formatting, and analysis. 

The information contained within boxes below is essential to our tutorial. The remainder of the information 
relates to more advanced functions. Additional discussions of possible analyses in Phon and related 
workflows can be found in Rose & Stoel-Gammon (2015) and McAllister Byun & Rose (2016).

2 Instructions toward Phon setup for this tutorial

Please follow the steps below to install Phon on your computer:

Download Phon: 

• Access the version relevant to your computer at https://www.phon.ca/ 
• Make sure you to choose the very latest version of Phon. The tutorial below was created using Phon 

3.1.3. 
• If you are installing Phon on your computer for the first time, launch Phon at least once so it can 

complete its own setup.

Download the Phon Tutorials project files:

• Access the Workspace and Media folders from the Resources section of the PhonBank portal 
(https://phonbank.talkbank.org/). 

• Note: The tutorial below does not require that you download and install the media files. But they are fun 
to have, and offer useful examples from different types of corpora, from three different languages, 
including one corpus (L2 English) that include Praat TextGrids.

Install the tutorial folders on your local drive:

• Decompress (unzip) the folders.
• Move the project folders into the PhonWorkspace folder located on your hard drive
• Move the media folder to a convenient location on your local drive.* For example, you can rename the 

Media folder as “PhonMedia” and place it adjacent to your PhonWorkspace folder on your drive. 
• *Do not enclose your media folder within your PhonWorkspace.
• Launch Phon (if it’s not already launched) or click "Refresh" near the top right corner of the Project list 

within the Welcome window. 
• Set the location of your media folder within the Phon general preferences

Related YouTube tutorials: 
• Shorter summary  
• M  ore detailed instructions  

1

https://youtu.be/cVYr1cBTTQY
https://youtu.be/F67Vvz1dSks
https://phonbank.talkbank.org/
https://www.phon.ca/


When everything is well set-up, the training folder should appear within the Welcome window, as in the 
screen capture below, you are technologically ready to go. If not please revise the steps above.

3 Project folder structure [skip this section if you have ]

Phon differs from many common software programs in that you cannot launch it through simply double-
clicking on a corpus file. This is because Phon operates within dedicated folders: 

(1) Phon folders
a. Workspace: Directory that contains your Phon project folder(s). 
b. Media: Directory that contains your media files. 

• The best method to assign a media folder for each project, using the option available in the top 
portion of the Project Manager window.

• We also recommend that:
◦ Media filenames match that of the corresponding Phon files (except for the file extensions)
◦ The media files are organized in individual folder, for each corresponding corpus

Related YouTube tutorial

Because the tutorial files contain data that have already been prepared to learn the query functions of 
Phon, we skip all the steps related to data preparation (e.g. media-linking, data transcription, annotation, 
and validation), and move directly to Phon’s basic methods toward data analysis based on transcription 
data.1

1 Future versions of this document will include methods toward acoustic data measurement. The interested 
reader is invited to watch the YouTube tutorial on this topic.
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4 Transcript-based analysis within Phon

4.1 Data Tiers: Queries based specific tiers within Phon records

This is useful to look for particular words or phonological contexts. 

You can look for strings of characters by using the Query >> Data Tiers query function. Within this function, 
you must type up the name of the tier you want to query. (This is case-sensitive, so you must use 
capitalization as used in the tier names contained within your data sessions.) From there you can enter the 
textual string, regular expression, or phonological expression you want to use in your query.

Related YouTube   tutorial  

4.2 Phones: Queries based on phonological descriptions

This is useful to look for phonological contexts as well as target-actual phone alignment data within these 
contexts. 

After your data have been properly verified, they are ready for empirical research. In Phon, we perform 
searches using the different query functions. Reporting consists of exporting your search results in formats 
that will be useful for graph generation and post hoc analysis. This document provides the basics on these 
two important steps. 

Related YouTube   tutorial  

4.2.1 Basic phonological expressions

Phonological expressions are used to specify phonological properties of your transcribed data beyond the 
IPA characters themselves. Below are more examples, with explanations:

(2) Phonological expressions
a. Phones can be listed directly; e.g. k will return all examples containing [k] in the data. Similarly, 

kw will return all [kw] sequences (beware of intervening diacritics such as syllable stress markers!)

b. {} returns any phone (formal logic: the empty set is the universal set!)

c. {feature, feature, …} returns phones corresponding to the feature sets specified (e.g. 

{obstruent, labial, voiced} returns consonants such as [b,v].

d. {c} or \c returns any consonant, {v} or \v returns any vowel and {g} or \g returns any glide.

e. {c}{c} returns any consonant cluster, irrespective of syllabification.

f. {c}:o returns any consonant in onset position (including within clusters).

g. s:l returns all cases of [s] in left appendices.

h. {c}{c}:o returns a sequence of one consonant (whichever its syllabification) followed by a 
consonant in onset.

i. {c}:o {g}:o returns onset clusters within which the second consonant is a glide.

j. {c}:o {-g}:o returns branching onsets where the second consonant is not a glide.

Related sectioni in Phon Manual (online)
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4.2.2 Quantifiers

Phonex also works with quantifiers, which affect the cardinality of the phone preceding them. 

(3) Phonex quantifiers
a. ? Zero or one

b. * Zero or more (where more can be one, two, three, …)

c. + One or more

Using these is particularly useful when you don’t want to limit your search to a single unit. For example:

(4) {}:o+ 

will give you a list of all onsets, be they composed of a single consonant or more than one consonants. 

Similar to mathematical constructs, it is always challenging to learn about the expressions and quantifiers 
above without applying them to practical problems. The next section offers a practical example of how we 
can use queries in Phon. Additional documentation and examples can also be found in the online Phon 
User Manual.

5 Phon query and report: A practical tutorial

This example is based on a subset of the data from child Catootje originally documented as part of the 
Dutch-CLPF corpus available on PhonBank (Levelt 1994; Fikkert 1994). A simplified version of this corpus 
is included in the Phon Workspace folder which you can download from the Resources section of the 
PhonBank portal, alongside its corresponding Media folder. In the context of the exercise below, we do not 
need access to the media folder.

Background knowledge relevant to this exercise: The consonant |d| in syllable onsets (e.g. day, under) is 
predicted by virtually every theory of phonological development to be acquired early, alongside similar 
consonants |t| and |n|. During stages where |d| is not yet acquired by the learner, patterns of devoicing (to 
[t]) should represent one of the most common error, given widespread issues with the development of 
voicing contrasts in Dutch (Levelt 1994) and other languages (e.g. Smit 1993, 2007 for English). However, 
Catootje displays very prominent variation patterns in her productions of words containing |d| in syllable 
onsets. This is best seen in an organized chart that summarizes Catootje’s patterns of phonological 
production for |d|.

To help you get started toward building that chart, I set up a custom query within Phon, called “[d] in 
Singleton Onsets” which you can
access directly through the Query menu
once you are within the Dutch-CLPF
(sample) corpus. 

Upon selecting this menu option, Phon
will generate a query script, presented
as a user-fillable form, pre-filled with the
criteria needed to look for |d| in
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singleton onsets. This pre-set query is in fact a Phones query form with all the criteria pre-entered, so you 
can see what a valid query looks like in Phon.2 The screenshot below explains how each of the criteria 
contribute to isolating the phonological context:

After you validate that this query is appropriate for you needs, select the session(s) you are interested in 
researching using the checkbox system in the left bar. You can then run the query using either the “Run 
query” button located in the top left corner of this screenshot; else you can hit next within the breadcrumb 
interface located above the query form within the Phon interface:

After you run the query and move to the Report Composer, still through the breadcrumb at the top of the 
query interface, you will find, within the Project Reports section of the interface, two preset reports:

Given the current query, the aggregate included in both reports maps within a single table all of the |d| in 
singleton onsets in IPA Target forms with their corresponding productions (and deletions) in IPA Actual 
forms, while the data table lists each one of these examples alongside the Orthographic, IPA Target and 
IPA Actual word forms in which they appear. Among other uses, the data table different word forms and 
phonological contexts. This will become useful soon. 

To add either of these reports to your Report List, double-clicking on it from the Reports list. Once your 
report of choice is loaded within the Report List, you can then run the report by clicking on the next step 
within the breadcrumb. Phon will then generate a report preview. 

2 To look for singleton onsets is in fact one of the trickier things to do in Phon. In most queries, the “Aligned 
Phones” section of the query form does not need to be filled. Note as well that the screen shot only 
illustrates the phonological query part of the query form; in the Word section of the form, tiers are listed to 
include the orthographic, IPA target and IPA actual transcriptions of the word forms which contain |d| in 
singleton onsets.
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Using this preview and the functions available from its toolbar, you can:

• Visualize your results. In case you want to reexamine a particular example from the result table, 
you can click on this example and Phon will open it within the Session Editor, where you can further
examine it. 

• Save the report as an HTML file (e.g. useful to print it, or otherwise share it in a formatted fashion)

• Export the report as:

◦ Excel workbook

◦ A set of individual Excel worksheets

◦ CSV (comma-separated value) text file

▪ This latter option facilitates the opening of your report in, e.g., LibreOffice Calc, SPSS, or R 

A look at the aggregate in this preview reveals some leading patterns (e.g. accurate productions, in the top 
line of the aggregate, deletions, in the second line), in addition to a large variety of more minor substitutions
for |d|, most of which present in negligible numbers, also often scattered across the data sample.3 If your 
research focuses on general patterning, as opposed to the details of variability (which has its own interest!),

3 For example, Catootje’s data present a number of marginal substitutions. The reader interested in these can 
retrieve individual examples listed in the data table of the Phon report (now saved in additional worksheets 
within the Excel workbook), or using a new aligned Phones query (looking for d:o in IPA Target aligned with 
the consonant l in IPA Actual). 
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it is often preferable to group these marginal patterns within an ‘Other’ category; it visually clarifies the large
picture. 

We thus need to ‘distill’ the aggregate into general categories; in the present case, leading patterns are:

• Accurate production

• Devoicing

• Deletion

The image below shows the results of this work. The top table in this image is the raw aggregate (with 
minimal formatting of the column and row labels) obtained from Phon. The bottom table is the distilled 
aggregate. 

In the “Distill an aggregate report” online tutorial , you can watch an example of how we obtain the bottom 
table from the top one. The functions used in this tutorial, filmed using LibreOffice, are identical in Excel. 
The basic work shown in this video is to create a new table with the general patterns we want to represent, 
and to add the numbers in the cells from the table above to their corresponding cells in the table below, 
using operator functions such as “sum” and “+” operators of your spreadsheet program.4

Once you have obtained your distilled aggregate, you are ready to generate a chart from it, which will help 
us obtain the general picture of Catootje’s production of |d| in singleton onsets. 

4 I also briefly discuss how to make decisions about choosing what patterns to represent, given that different 
datasets generally present with different phonological patterns.
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5.1 Distill aggregate data into Microsoft Excel

The step-by-step method below starts with Phon’s report preview.

1) Export report as an Excel Workbook:

• From the Toolbar of the Report Preview, click on “Export tables >> Export tables as Excel workbook”

• Save your file in a location where you can retrieve it easily (e.g. Desktop)

• Open in Excel

2) Within Excel, group your aggregate data according to the general patterns observed.

• See "Distill" YouTube tutorial for how to do this.

The distilled aggregate, which contains the same number of results as the original aggregate above it, can 
then serve to generate a graph, from which the leading patterns, and the general proportions of the data 
they represent, will visually stand out.

Step-by-step instructions in Excel:

• Select the distilled aggregate and its labels on the X and Y axes (B20:R24 in table above)

• Choose menu “Insert > Chart > Bar”

Excel will then generate a chart that needs a bit of final formatting. To obtain a stacked column chart:

• Right-click on the newly-generated chart and select Change Chart Type > Column > 2-D Stacked Column

(or other stacked columns of your choice, for example if you want a 3-D chart):

To reorder the production categories such that the leading patterns appear on top of the chart, which 
improves the readability of your chart:

• Right-click again on the chart and select option “Select Data”. 

• Click on the row labels and use the arrows to fix their ordering within the chart.
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You can then further customize your table with a different colour palette, etc., which might then result in 
something like, with a visual colour scheme analogous to traffic lights, whereby green represents accurate 
productions, yellow the substitutions, and red the deletions; other substitutions are representations in more 
neutral grey.

As we can see from these data, Catootje displays a persistent pattern of deletion affecting |d| in singleton 
onsets throughout the period documented by the corpus. This completes the technical descriptions relevant
to this tutorial. Further considerations are discussed, starting in section 5.3, toward a further understanding 
of this variability.
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5.2 Distill aggregate data into LibreOffice Calc

The step-by-step method below starts with Phon’s report preview.

1) Export report as a CSV files:

• From the Toolbar of the Report Preview, select: Export tables >> Export tables to folder (CSV)

• Save your folder in a location where you can retrieve it easily (e.g. Desktop)5

• Within this folder is your aggregate file, named “Aggregate by age.csv”. Open it in LibreOffice.

LibreOffice will then open a window to validate the format in which you want to import the CSV file. 

Key to the settings of this window are:

• Character set: Unicode6 

• Separator options: Comma

• String delimiter: "

2) Within Calc, group your aggregate data according to the general patterns observed  (as in the "Distill" 
YouTube tutorial referenced above).

5 By default, Phon will name this folder “Phones”. We recommend you give it a more meaningful name, which 
reflects the detail of your query.

6 While the present example uses UTF-8, UTF-16 may be required at times. You know you have the right 
encoding when you can read the IPA symbols in the table preview at the bottom of this window.
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The distilled aggregate, which contains the same number of results as the original aggregate above it, can 
then serve to generate a graph, from which the leading patterns, and the general proportions of the data 
they represent, will visually stand out.

Step-by-step instructions in LibreOffice Calc:

• Select the distilled aggregate and its labels on the X and Y axes (B20:R24 in table above)

• Choose menu “Insert > Chart…”

Calc will then open a wizard to format your chart. The relevant settings are represented in the three four 
screen shots:

Choose chart type:

Set option “Data series in rows” (as opposed to columns)
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Order your data series (rows) by order or prominence:

You can then further customize your table with a different colour palette, etc., which might then result in 
something like, with a visual colour scheme analogous to traffic lights, whereby green represents accurate 
productions, yellow the substitutions, and red the deletions; other substitutions are representations in more 
neutral grey.

As we can see from these data, Catootje displays a persistent pattern of deletion affecting |d| in singleton 
onsets throughout the period documented by the corpus. This completes the technical descriptions relevant
to this tutorial. Further considerations are discussed next, in order to peek into this variability.

5.3 Where can we go from here?

This is where the fun begins, toward the interpretation of these query results. For example, these data are 
intriguing in particular concerning the high variability of |d| productions throughout the entire period of 
Catootje’s development documented by the corpus. 

In order to peek into variation such as this, it is often best to begin by visualizing individual examples, here 
the set of words (and the phonological contexts they involve) where |d| is produced accurately and where it 
undergoes deletion. Contrasting these examples may reveal that the different patterns emerge from 
different phonological or phonetic contexts. From these observations, you can formulate hypotheses about 
the factors that may be driving the variation in the data (in particular, the pattern of |d| deletion), and test 
the empirical adequacy of your hypotheses through further queries in Phon.

This is the essence of the exercise proposed below.
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6 Further exercise: Toward an understanding of Catootje’s |d| productions in syllable 
onsets

Aim of the exercise: Practice your use of Phon through a further exploration of Catootje’s production 
patterns for |d|. 

Context: As we saw above, Catootje exhibited an intriguing pattern of deletion for |d|, which varied most 
prominently with accurate and devoiced productions within the data. 

Some questions: 

• Is this variation phonologically conditioned?

• If yes:

◦ What phonological contexts predict each of the two leading patterns observed in the data?

◦ How can we explain how these contexts influence Catootje’s phonological behaviours?

In order to answer these questions, best is to start looking at examples that display accurate productions 
vs. those that contain |d|-deletion. This is where the “Data table by session”, an option available within the 
Phon project created for this Tutorials series, as discussed at the beginning of section 5 above will become 
useful, as it enables us to consider every example of deletion in the context of the word form it was 
produced. 

Step 1: Using the data tables, make observations about the contexts where you find deletions vs. those 
where you find accurate productions.

Once you have one or two working hypotheses, you can use a Phon queries to ‘isolate’ the phonological 
context(s) where you expect the deletion pattern to reveal itself. The basic idea is that if you think that 
deletion occurs in a given context, your phonological description of this context should capture all (or most 
of) the cases of |d| deletion observed in the data. Within Phon, you should then be able to formulate a 
query for this precise phonological context, which would result in a high number of |d|-deletions. 
Conversely, you should also be able to formulate queries which explicitly avoid the relevant context; this 
latter query should in comparison yield relatively few deletion cases.

Step 2: Run new Phon queries in order to test your working hypothesis. 

For starters, here are a few questions you can ask:
• How do other Cs behave in the same syllable positions? 

◦ In particular, do the obstruent stops (e.g. |b|, |g|) also show extensive patterns of deletion? 

• What are the behaviours of |d| in other syllable positions? (e.g. branching onsets)? 

• Can consonants or vowels adjacent to |d| be involved in the variation observed?

(Note: Dutch generally does not allow for voiced obstruents in syllable codas. For sake of the current 
exercise, I suggest you only focus on the behaviour of |d| in syllable onsets, in relation to other sounds that 
are adjacent to it within the words.)
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For each query, you can visualize your overall results without generating a graph each time, in order to test 
your hypotheses. You goal, as in research more generally, should be to arrive at the smallest number of 
hypotheses to capture a maximum number of observations. 

Once you have validated your hypotheses, in that your queries and results capture the essence of the 
variation you observed in the data, you can then distill these ‘final’ aggregates and generate charts relevant
to both the deletion pattern and the accurate productions. These charts can then be used in your paper 
write-up.

Step 3: Distill final aggregates and generate charts that illustrate your analysis.

At this stage, you have obtained a clear picture of the phonological contexts driving each of Catootje’s two 
most prominent behaviours concerning |d| in singleton onsets. Your next logical task is to then interpret 
each pattern in context, so that you can not only show in what phonological contexts each behaviour arises
in the data, but also offer some reflections as to what factors may be at play in each relevant context.

Step 4: Data interpretation.

Different theories of phonology and phonological development can describe this variation. Given what you 
know about the literature on the topic, what would be your best explanation for Catootje’s patterns of |d| 
production?
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